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NEW Prince Castle 2nd Generation PHU with Temperature pass-thru 
feature from PCminder/Kitchen Minder v6.0 

Requirements: 
1- PCMinder AND Kitchen Minder requires v6.01 software 

PCMinder - Check the software on your PCMinder by clicking Help, About 

 

 

 

 

 

 

 

The version must be v6.01.55 or higher to function with the Prince Castle Gen2 PHU’s.  If your 
version is not v6.01.55 or higher, please go the section on Page 2 labeled: 

Upgrading PCMinder and Kitchen Minder to 6.01+  

Kitchen Minder - The KM1 and KM2 software must be on v6.01 or higher to function with the 
Prince Castle Gen2 PHU’s. If your version is not v6.01 or higher, please go the section on Page 
2 labeled: 

Upgrading to PCMinder and Kitchen Minder to 6.01+  

2- New PHU’s require New Prince Castle Translator II Kits – Kit Part# 990198 

Order kits directly from ICC by calling +1-631-673-5100 or email: support@goicc.com 

Each kit costs $219, all necessary cables are included. To determine how many kits are 
required for your PHU configuration and instructions on installing/configuring your New Gen2 
PHU’s, go to the section labeled: 

Connecting and configuring Prince Castle Translator II Kits to the Kitchen Minder 
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Upgrading to PCMinder and Kitchen Minder to 6.01+  

Version 6.0 requires a valid software license and is Included with Kitchen Minder Systems 
shipped on or after March 20, 2014. Regardless of the ship date, all KM2 color units have an 
included license. 
 

Kitchen Minder1 (KM1) Systems shipped prior to March 20, 2014 require a Paid Upgrade 
License upgrade. 

To purchase the Paid Upgrade license, pay on-line at the following Kitchen Technology 
Innovations link : http://shop.onkti.com/ 
 

To upgrade your system: 

 
1. On the back-of-house (BOH) computer, go to www.goicc.com 
2. Click on the Burger King icon toward the top right of the screen 

 

 

 

 

 

 

 

3. Select your country by clicking on the correct flag 
4. Find and select Download v6.0 Kitchen Minder/PCMinder software 
5. Download and run the install KMSS package and click Next through the first four install 

screens, then Install, and then click Finish at the end. For upgrades, do not check the 
box when it asks if you want to use QES Minder. For 1st time installations, check the box. 

6. Run the new version of PC Minder. 
7. Validate that the correct version of PC Minder is installed by clicking Help, About on the 

top bar. The dialogue box that pops up should say that version 6.01.55 or higher is 
installed. 
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8. Your BOH Computer should already be connected to the “Programming Port” of the 

Kitchen Minder and tested during the initial installation.  See your Kitchen Minder 
Installation guide for details.  
 
If you can successfully send data from PCMinder 
to the Kitchen Minder the connection is OK and 
skip to # 10. 
 
If data transmission fails go to #9. 
 
 

 
9. Run a communications test 

While the Kitchen Minder is on, go to PC 
Minder. Under the “Tools” tab, select 
“Communication Test”  

Enter “admin” as password when prompted. 

 

 

On dialogue box that pops up, select “Find 
Serial Comminications Port” 

If it finds a serial communications port, it will 
tell you which port it found, and you can move 
to step 10. 

 

If there is no port found, it will give you an 
error message like the one shown on the right. 

You will need to check the connections between the 
computer and the Kitchen Minder, COM Port 
assignments in Windows Device Manager and USB-
Serial Drivers .Replace any suspect parts and test 
again. 

10. Check the software version of your current Kitchen Minder 
unit by recycling power on the unit and observing the 
bottom right corner of the screen for the version number. If the 
version is 6.01 or higher skip to Page 5. If the version number is 
lower than 6.01, continue to step 11. 
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11. Check which Kitchen Minder unit you have (KM1 or KM2) by looking on the back of the 

unit.  

 

 

 

 

 

 

 

 

 

12. To upgrade the Kitchen Minder unit: 
a. Return to PCMinder on the BOH computer 
b. Go to the “Tools” menu on the top ribbon and scroll over “Device Upgrades” and 

select Kitchen Minder 1 or Kitchen Minder 2 depending on which unit you have.  
c. If prompted, enter “admin” as the password and select “OK” 
d. When the dialogue box appears showing that you have an upgrade, select the 

“Reprogram” button 
e. Power the Kitchen Minder unit off, WAIT 10 seconds, and then turn it back on, 

then select “Continue” on-screen. 
f. As progress is displayed, DO NOT use the computer or Kitchen Minder during 

the 5-10 minutes of the upgrade process. 
g. When “Programming Complete” is shown, select the “OK” button. If this upgrade 

fails, repeat steps a-f. If still unsuccessful, call ICC Tech Support. 
h. Repeat step 10 before proceeding, in order to verify correct software version on 

Kitchen Minder. 
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Connecting and configuring Prince Castle Translator II Kits to the Kitchen Minder 
Identifying the different model types or your new Prince Castle Gen2 PHU’s 

Model identification#: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

DHB-BK22E 
1 Button Bar Channel 

DHB-BK23E 
1 Button Bar Channel 

DHB-BK24E 
1 Button Bar Channel 

DHB-BK32E 
2 Button Bar Channels 

DHB-BK42E 
2 Button Bar Channels 

DHB-BK34E 
2 Button Bar Channels 
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1. Place new Prince Castle Gen II Holding Bins on a flat surface in the location in the 
kitchen designated by the store manager. 

Bins may be stacked up to (4) shelves high, BUT ensure that all employees can 
reach product on the top shelf. 

IMPORTANT: To prevent injury, team-lift the bins 

2. Connect black power cable from the back of each holding bin to a matching grounded 
plug. Power unit on with green switch on front. 

 
3. Determine Bin Configuration(s) to be used. 

A total of (3) button bar channels can be grouped together to comprise a 
configuration. All possible configurations are listed in the figure below. Notice that 
it does not matter which bin is the ‘First Bin’, all possible orders are listed. Please 
choose the configurations based on the physical grouping of bins in the store, 
then minimize the number of configurations used, you cannot exceed (3) 

configurations.  

 

 

 

 

 

Bin Name Size Button Bars
DHB-BK22E 2x2 1
DHB-BK23E 2x3 1
DHB-BK24E 2x4 1
DHB-BK32E 3x2 2
DHB-BK34E 3x4 2
DHB-BK42E 4x2 2

Part# 990198-1 

Prince Castle Translator II Kit  - $219  

includes: 

980198, Prince Castle Translator II Box 

681-6x6-12#: 1ft. (30 cm) Data Cable 

681-6x6-96#: 8ft (2.4m) Data Cable 

681-6x6-168#: 14ft. (4.3m) Data Cable 

681-8x8-600#: 50ft. (12.2m) CAT5 Cable 

660000, Cable Ties (2) 

Part# 990198-1 

Qty-1 Prince Castle Translator II Box 
with the appropriate cables is required 
for each configuration A-F for maximum 
of 3 connected to the Kitchen Minder 
Ports 1-3 

NOTE: Use ONLY ICC data cables for 
PC II Box & PHU interconnections. 
These are 6 conductor Pin1-Pin1 cables. 
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4. Connect Kitchen Minder to Prince Castle Translator II Box (PC II Box) 

You will need (1) PC II Box and Ethernet cable for each configuration chosen 
(max. 3 boxes). Connect one end of the Ethernet cable into the Kitchen Minder 
port (1-3) and the other end into the FROM KM port on the PC II Box. 

NOTE: Verify that the black box says “PRINCE CASTLE TRANSLATOR II P/N 
980198” on the label of the box. If not, get a new box from Prince Castle or your 
service agency before proceeding.  

Repeat this for up to (3) configurations using the COM1, COM2, and COM3 ports 
on the Kitchen Minder in order. 

 

 

 

 

 

 

 

 

 

NOTE: All cables are intended to be permanent, DO NOT remove or disconnect 
cables and do not move bins which may compromise the cable/connections. 

5. Connect to First PHU 

Connect an ICC data cable from the TO PHU port on the PC II Box to the IN port 
of the First PHU in each configuration.  

Connect multiple bins together: 

If you are using a configuration that 
uses multiple bins, you will need to 
connect them. This is done by 
connecting an ICC data cable from 
the OUT (black) port of the First Bin 
to the IN (white) port of the Second 
Bin. If 3 bins are in the configuration, 
you will also need to connect an ICC 
data cable between the OUT port of 
the Second Bin to the IN port of the 
Third Bin  

Port labeled “FROM KM” 
connects to KM COM1, 
COM2 or COM3. Port 
Labeled TO PHU connect 
to IN Port of 1st PHU 

Use only ICC cables to connect PHU’s, 50’ max.: 

Part No. 681-6x6-96#, 8ft. (2.4m) Data Cable 

Part No. 681-6x6-168#, 14ft. (4.3m) Data Cable 

Part No. 681-6x6-600#, 50ft. (12.2m) Data Cable (optional ordered 
separately) 

Use the 1ft (30 cm) data cable and 2 cable ties provided to connect box to the 
1st PHU and attach box to cables. 

1st Bin to 2nd Bin or 2nd Bin to 3rd Bin 
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6. Set Bin Addresses 

To allow the Kitchen Minder to properly communicate with the bins, bin 
addresses need to be correctly set as shown in the table below.  

Bin 
Address

Bar 
Address(es)

Bin 
Address

Bar 
Address(es)

Bin 
Address

Bar 
Address(es)

BAR 2

BAR 2 BAR 3

BAR 2 BAR 3 BAR 4
BAR 4

BAR 2 BAR 3
BAR 3
BAR 2
BAR 3
BAR 2 BAR 4

E BIN 2

BIN 4F BIN 2

D BIN 2 BIN 3

B BIN 2 BIN 3

BIN 4C BIN 2 BIN 3

Configuration
First Bin Second Bin Third Bin

A BIN 2

 

This is done using the control panel on the front of the PHU. First, check what the 
current Bin Address is by pressing and holding the ACTUAL TEMP and SET-
POINT buttons at the same time until the Bin Address is shown on the display. If 
the correct Bin Address is shown, proceed to step 10. 

To change an incorrect Bin Address, first power off the unit. After waiting 5 
seconds, power it back on and immediately hold the ACTUAL TEMP and SET-
POINT buttons until the small PROG LED lights up. After it is lit, release the two 
buttons and scroll using the up and down arrows until the desired Bin Address is 
displayed. Then press the Prince Castle logo button to confirm. 

Complete this process on each bin until all Bin Addresses are correct. 

The numbering of one configuration has NO impact on the numbering of a 
different configuration. 

 

 

 

 

 

 

 

 

 

SET-POINT 
BUTTON 

ACTUAL 
TEMP 

UP AND 
DOWN 

ARROWS 

BIN 
ADDRESS 

PROG 
LED 
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7. Set Bar Addresses 

To allow the bin to properly communicate with the timer bar(s), bar addresses 
need to be correctly set as shown in the table above. This is done directly on the 
timer bar. First, check what the current Bar Address is by pressing and holding 
the Prince Castle logo button and the down arrow button until the Bar Address is 
shown on the far right screen of the button bar.  

To change an incorrect Bar Address, first power off the unit. After waiting 5 
seconds, power it back on and immediately hold the Prince Castle logo button 
and the down arrow button until the address number starts blinking. Release the 
two buttons and scroll using the up and down arrows until the desired Bar 
Address is displayed. Then press the MENU/ENTER button to confirm. 

Complete this for each button bar channel on all of the bins. Remember that 
button bars on the back of a unit are considered auxiliary and do not need to be 
separately programmed. These bars follow the programming of the bar on the 
front side of the same shelf. 

Be sure to follow the numbering system as prescribed in the table. In the table, if 
two Bar Addresses are stacked on each other, this reflects the way the bars are 
oriented on the unit (i.e. the bar on the bottom in the table represents the bar on 
bottom on the unit). 

The numbering of one configuration has NO impact on the numbering of a 
separate configuration.  

 

 

 

PRINCE CASTLE 
LOGO BUTTON 

UP AND DOWN 
ARROWS 

MENU/ENTER 
BUTTON 
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Setting up PC Minder for Daily Use 

1. In PCMinder on the BOH computer, Load 
Product Profiles for all products to be used 

 

 

 

 

a. Navigate to the “Product Settings” 
screen 

 

 

 

 

 

 

 

b. To load the profile for each product, 
double-click in the “Warmer Type” 
column for the product. 

 

 

 

 

 

 

 

c. After the “Warmer Type” dialogue box 
pops up, click on the “PC Dual Temp” 
tab along the top.  
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d. Select “Load Profile” from the buttons 
along the bottom.  

 

 

 

 

 

 

 

e. Find the product you are programing in 
the menu that pops out and click on it. 
Match the abbreviation shown to the 
product profile that you load. 

 

 

 

 

 

f. When the menu pops back in, select 
“Save”  

g. Repeat b-f for all products you use in 
your store for all Day Parts. You can 
change Day Parts by clicking on the 
current Day Part button towards the top. 
(If you load a product profile in one Day 
Part, you do not need to load it again in 
another Day Part) 

 

 

 

2. Program the Holding Bins for Kitchen use 
 

a. Navigate to the “Program PHU” 
screen 
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b. Determine how your bin configuration 
relates to PC Minder.  
 
For each configuration you chose in the 
setup, you will need to use one row in PC 
Minder, so start each new configuration in 
a new row starting from the top. Each row 
represents a COM port on the Kitchen 
Minder (top row is COM1, middle is COM2, 
and bottom is COM3). 
 
The colors in the figure to the right show 
which trays correspond with which boxes 
on  PC Minder. Notice that some bins 
require you to use multiple sections of 
boxes on PC Minder, you MUST start each 
bin in its own section (e.g. if a bin uses the 
a whole section and the top of a second 
one, the next bin should go in the third 
section). Do not place products in the 
boxes that are not shaded. 

 

 

c. Change each section you will use to 
“PC Dual Temp” from “Duke/ PC 
PHU” by clicking on “Duke/ PC PHU” 
then selecting “PC Dual Temp”. 

 
d. Based on which configurations you 

used in setup, choose products to be 
held in the bins. Do this by clicking 
anywhere in a white box and 
selecting the product from the 
dropdown menu. (NOTE: each half 
of each row in a section must match, 
if they do not, they will display in red. 
Acceptable pairings will show in 
blue) If you do not want to use a 
tray, you may select “-none-“. 
 

e. Select a product or “-none” for each 
tray on all of the bins for each Day 
Part.  

 

 

** On a 2x3 unit, you must put products in all four slots across 
in order to communicate properly with PC Minder. The products 
in the two bottom right shelves must match and the products on 
the two top right shelves must match.** 
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f. Save programming by selecting 
File>Save on the top ribbon.  

 

 

 

 

g. Send Programming to Kitchen Minder 
by navigating to “Send to Kitchen 
Minder” Screen and selecting “Send 
Forecast”. Wait for the process is 
complete, it will take about 5 minutes. 
You should hear beeping on the 
Kitchen Minder unit to validate that it is 
sending data. 

 

h. Go to bins and verify that all bars 
display the correct products in the 
correct locations, if not, check 
through your settings in step d and e 
and then repeat step g if necessary. 

 
i. Check that the temperature setpoint 

for each Zone match what was 
programmed in PCMinder, , if not, 
check through your settings in step d 
and e and then repeat step g if 
necessary 


